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Uvod T

Trajanje
Na ovoj radionici polaznik ¢e se upoznati s osnovama uporabe poglavlja:
besplathog programa Audacity za snimanje i obradu zvuka. 10 mi
min

Na radionici ¢e polaznici steéi osnovnu razinu znanja o zvuku i
njegovim karakteristikama te ¢e nauditi termine koji se koriste prilikom
obrade zvuka. Naucit ¢e se koristiti mikrofonom i osnovnim alatima u
programu Audacity za snimanje, reprodukciju i obradu zvuka,
dodavanje efekata te ¢e se upoznati s formatima za uvoz i izvoz
zvuCnih zapisa.

Za oznacCavanje vaznijih pojmova, naziva naredbi i elemenata sucelja
te naziva drugih objekata koji se nalaze na ekranu, koriste se
podebljana slova.

Put do naredbe pisan je kurzivom, a sama naredba podebljano,
primjerice Edit > Remove Special - Split cut.

Prec€aci na tipkovnici oznaceni su ovako: [F1], [Ctrl]+[Alt]+[Del] i sl.
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1. Zvuk i njegove karakteristike e

“ . L . Trajanje
Po zavrSetku ovog poglavlja polaznik ¢e moci: poglavlja:
° navesti karakteristike zvuka i osnovne termine povezane s 20 min

obradom i snimanjem zvucnih zapisa
e razlikovati niske i visoke frekvencije zvuka
e razlikovati intenzitete zvuka

° opisati karakteristike tona zvuka.

1.1. Zvuk

Zvuk je mehani€ki val, odnosno vibracija koja se Siri preko medija, kao
8to su zrak ili voda. U psihologiji i fiziologiji, zvuk predstavlja
mogucnost registriranja tih mehanickih valova i njihovu percepciju u
mozgu.

Zvuk stvaraju objekti ili subjekti vibracijom. Na isti nacin vibriraju slusni
organi, Sto zivim bi¢ima omogucuje da Cuju razliCite vrste zvukova.

Na sljedeco; slici prikazan je izvor zvuka (bijeli krug) i vibracije koje taj
izvor stvara.

Izvor: https://upload.wikimedia.org/wikipedia/commons/8/82/Spherical_pressure_waves.gif

Zvuk karakteriziraju frekvencija i jacina. Da bi ljudi Culi zvuk, vrijednosti
frekvencije i jacine moraju biti u razini Cujnosti slusnih organa.

1.1.1. Frekvencija zvuka

Frekvencija zvuka oznacCava broj ponavljanja valova ili vibracije u nekoj
jedinici vremena.

P T AT Y [ vty Ty Ty My AT AN

Val vece frekvencije: ' l f
W L U A W A W W L R R A

Val manje frekvencije: ' \ . J \

@ srce ’


https://upload.wikimedia.org/wikipedia/commons/8/82/Spherical_pressure_waves.gif
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Visina zvuka vezana je uz frekvenciju i to tako da ako se povecava
frekvencija zvuka, povecéava se i visina.

Kako visina zvuka ovisi o frekvenciji i kako izgledaju valovi razlicitih
frekvencija prikazano je u animaciji na web-stranici
https://meettechniek.info/additional/additive-synthesis.html.

1.1.2. Jacdina zvuka

Jedinica za jacinu zvuka (subjektivni intenzitet) je Bell. Granica Cujnosti
jest 0 dB, dok se 3apat, govor i buka krecu od 30 do 90 dB, a granica
boli je 120 dB.

Jacina zvuka graficki se prikazuje visokim i niskim amplitudama:

Val veéeg intenziteta (vece jacine): ) j’ \\'l j k j \ { (

Val manjeg intenziteta (manje jacine): —,  —, M\ j"“\\ N
\J U O ./

1.1.3. Ton zvuka

Ton je zvuk koji uz visinu i ja€inu karakteriziraju jos trajanje i boja, sto
ga razlikuje od drugih, neodredenih zvukova (kao $to je, na primjer,
sSum).

Trajanje ovisi o vremenu emitiranja zvuénog vala.
Ton traje sve dok izvor zvuka proizvodi vibracije.

Boja ovisi o broju i jagini popratnih tonova koji se javljaju istodobno s
glavnim tonom. lako ih nije moguce svjesno prepoznati sluhom, utjecu
na ljudsku percepciju tona jer mu pridaju specifi¢no i prepoznatljivo
zvucanje - boju.

1.2. Snimanje, obrada i reprodukcija zvuka

Zvuk se moZze snimati, obradivati i reproducirati.

Za snimanje se Koristi mikrofon koji sluzi kao prijemnik zvuénih valova i
pretvara zvu€ne valove u elektri¢ni signal koji se kodira u slijed
digitalnih vrijednosti. Obrada zvuka odnosi se na manipuliranje
digitalnim podacima u racunalnom programu.

Digitalni podaci, koji se u racunalu definiraju kao zvuéni format,
reproduciraju se stvaranjem elektri€nih signala koji pomocéu zvucnika
stvaraju zvuéne valove.



https://meettechniek.info/additional/additive-synthesis.html
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Uredaji za pohranu

Zvuéni valovi

Zvuéni valovi

Elektritna Zvutnik

energija

Izvor: https://en.wikipedia.org/wiki/Digital_audio#/media/File:A-D-A_Flow.svg
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1.3.

1.

Vjezba: Zvuk i njegove karakteristike

Zvuk je (moguce je viSe odgovora):
a. mehanicki val
b. vibracija koja se Siri preko nekog medija
c. mogucénost percepcije mehanickih valova
d. sve gore navedeno

Nakon stvaranja, zvuc€ni valovi moraju se kretati kroz

da bi dosli do prijemnika zvuka.

Povezite pojmove:
Visina, ja€ina, boja i trajanje

frekvencija zvuka
zvuka.

Broj mehanickih valova u nekoj

jac€ina zvuka e
jedinici vremena.

ton zvuka Subijektivni intenzitet zvuka (dB).

Nacrtajte zvucni val slabijeg i jaCeg intenziteta.

Slijed digitalnih podataka pohranjenih na racunalu moze se

reproducirati pomocu . Osoba iste

vibracije u zraku moze proizvesti koristeci

prima zvuéne valove i pretvara ih u

elektricnu energiju koja se nakon pretvaranja u digitalne

vrijednosti na nekom digitalnom

mediju.
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2. Instalacija Audacityja, upoznavanje s e

radnim prostorom i snimanje zvuka Trajanje
poglavlja:
Po zavrSetku ovog poglavlja polaznik ¢e moci: 40 min

e spojiti mikrofon i sluSalice na racunalo

e  testirati rad mikrofona i sluSalica

e  Koristiti se mikrofonom za snimanje u Audacityju
e navesti mogucnosti obrade zvuka

e  prepoznati dijjelove sucelja programa Audacity.

Snimanje zvuka uklju€uje registriranje zvu¢nih valova koji se stvaraju
glasom (neartikulirani zvukovi, govor, pjevanje), glazbenim
instrumentima ili prirodnim pojavama i njihovo spremanje na medij za
pohranu, koriste€i raCunalni program za snimanje zvuka.

Danas se svakodnevno i jednostavno koristimo uredajima za snimanje
zvuka, pametnim telefonima, nesvjesni njihove kompleksnosti i razvoja
dugog 200 godina. Povijest snimanja zvuka pocinje s akusticnom
erom, proteze se kroz elektricnu i magnetsku eru, sve do digitalne ere
u kojoj se nalazimo danas. Digitalne tehnologije znatno
pojednostavljuju i proSiruju mogucnosti obrade i koristenja zvuka.
Snimanije, distribucija i prijenos zvuka veéem broju korisnika, na velike
udaljenosti i u kratkom vremenu, ucinili su snimanje i prijenos zvuka
nezamijenjivim alatom nase svakodnevnice.

Proces snimanja podrazumijeva mehanicko registriranje zvucnih
valova membranom mikrofona koja pomi¢e magnet u zavojnici. Takvo
gibanje proizvodi elektri¢nu energiju koja se vodi¢em prenosi do
analogno-digitalnog pretvornika koji pretvara analogne signale u slijed
digitalnih vrijednosti koje se mogu poslati ili pohraniti na mediju.

Za snimanje zvuka na ra¢unalo potrebno je spojiti mikrofon i instalirati
odgovarajuci racunalni program. Postoji mnogo komercijalnih i
besplatnih programa za snimanje i obradu zvuka, od profesionalnih koji
imaju napredne mogucnosti, do amaterskih u kojima se moze brzo i
lagano napraviti osnovna obrada zvuka. Programi za obradu zvuka
omogucuju snimanje, obradu i proizvodnju zvuka te se mogu instalirati
na racunalu ili koristiti kao web-aplikacija.

U ovom poglavlju objadnjeno je kako se mikrofon ispravno spaja na
raCunalo te kako se instalira i koristi program Audacity koji se ne
razlikuju mnogo od komercijalnih alata, tako da moze posluZiti i
naprednijim korisnicima, a zbog toga &to je besplatan i jednostavan za
koristenje izvrstan je alat i za neprofesionalne korisnike.

@ srce ’
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2.1. Instalacija i pokretanje Audacityja

Kako bi se zvuk pohranio na racunalo potrebno je Kkoristiti racunalni
program koji moze prepoznati digitalni signal koji dobije od mikrofona.

Uz vecinu operacijskih sustava instalira se i jednostavan program za
snimanje zvuka kojim se, pomocu osnovnih moguénosti, moze snimiti i
obraditi zvuk. Za naprednije moguénosti potrebno je instalirati
profesionalni program za snimanje i obradu zvuka kao $to je Audacity.

Za instalaciju Audacityja potrebno je preuzeti instalacijsku datoteku s
web-stranice http://audacityteam.org/. Nakon preuzimanja datoteke na
racunalo, potrebno ju je pokrenuti i slijediti instalacijski postupak. Za
pokretanje programa u operacijskom sustavu Windows, odabere se
Start > Sve aplikacije > Audacity.

Za pokretanje Audacityja u operacijskim sustavima OS Xi Linux,
odabere se Applications > Audacity.

2.2. Audacity i njegove moguénosti

Audacity je besplatan program otvorenog koda za snimanje i obradu
zvuka koji je dostupan za operacijske sustave Windows, OS X i Linux.

Obrada zvuka koristi se za preklapanje naracije s pozadinskom
glazbom, uklanjanje ili izolaciju naracije, izradu petlje zvuka (engl.
loop), izradu tonova zvona, rezanje zvu¢nog zapisa na vise dijelova,
izvoz zvuCne datoteke koja se moze reproducirati na racunalu itd.
Neke od mogucnosti programa Audacity su:

e snimanje i reproduciranje zvuka

e uvoziizvoz razli€itih formata zvuka

e obradivanje rezanjem, kopiranjem i lijepljenjem dijelova
zvucnog zapisa, tj. spajanje razliitih zvucnih zapisa

e preklapanje (mijeSanje) vise zvu€nih zapisa

o dodavanje raznih efekata

e uklanjanje Sumova i buke

e ubrzavanje i usporavanje zvu€nog zapisa

e postepeno smanjivanje i pojacavanje intenziteta zvuka
e dodavanje jeke

e i mnoge druge.



http://audacityteam.org/
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2.3. Radno sugelje

Pri otvaranju Audacityja prikazuje se radno sucelje s moguénostima
obrade i prikazom zvuénog zapisa.

Radno sucelje Audacityja sastoji se od 3 dijela:

1. glavnog izbornika koji sadrzi popis mogucnosti programa
slozenih u padajuce izbornike

2. alatne trake koje omogucavaju brz pristup mnogim
mogucnostima

3. zvuénih zapisa koji prikazuju snimljeni ili uvezeni zvuk.

Bz
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Stopped.

Glavni izbornik i prikaz zvu€nih zapisa nepomicni su, dok se po potrebi
alatne trake radi lakSeg koristenja mogu premjestati. Za premjestanje
alatne trake odabere se njezin krajnji lijevi dio i traka se odvuce na
zeljenu poziciju. Ako se zele resetirati alatne trake na pocetnu poziciju,
potrebno je oti¢i na izbornik View > Toolbars > Reset Toolbars.
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2.4. Spajanje mikrofona i slusalica na ra€unalo

Na gotovo svakom stolnom racunalu nalazi se priklju¢ak za mikrofon i
sluSalice. Na novija prijenosna racunala ve¢ su ugradeni mikrofoni, dok
svaki pametni telefon ima mikrofon i opciju za snimanje.

Na racunalo je mogucée spoijiti mikrofon, slusalice ili druge audio
uredaje koristeéi prikljucke za zvuk koji se nalaze na prednjoj, straznjoj
ili bo€noj strani racunala.

Standardni priklju€ci koje koristimo za snimanje i reprodukciju zvuka
su:

o priklju¢ak za mikrofon — ruzi¢aste boje

o priklju¢ak za razne audio-uredaje (mp3 player, glazbeni
instrumenti, mjesaci zvuka — miksete, dodatni mikrofon...) —
plave boje

e prikljucak za zvu¢nike — zelene boje.

Alternativni nacin spajanja audio-uredaja na racunalo je putem USB-
prikljucka.

2.5. Kontrole intenziteta zvuka pri snimanju i
reprodukciji

Alatna traka Mixer Toolbar ima mogucénosti pojac¢avanja i smanjivanja
inteziteta zvuka pri snimanju (lijevi kliza€) i reprodukciji (desni klizac).

‘!)— lﬂ+4i}_ o +

° @ srce
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2.6. Testiranje rada mikrofona

Prije pokretanja programa i testiranja rada mikrofona potrebno je
ispravno umetnuti priklju¢ak mikrofona u racunalo i konfigurirati
operacijski sustav da prepozna mikrofon (konfiguracija je razli€ita u
svakom operacijskom sustavu).

Za testiranje rada mikrofona potrebno je:

1. Odabrati spojeni mikrofon iz izbornika Recording Device iz
alatne trake Device (ako se mikrofon ne pojavljuje u izborniku,
potrebno je u operacijskom sustavu provijeriti je li ispravno
instaliran i spojen na racunalo).

Windows W \!/ Microphone (Realtek High C -~ |?_(Stereo) Record ‘D Speakers (Realtek High Defir

2. Kliknuti lijevom tipkom miSa na tekst Click to Start Monitoring
unutar alatne trake Recording Meter Toolbar kako bi se pratio
signal koji Audacity prima preko mikrofona.

3 . . . . . .
\!; q 54 :43 42 |Clic:kt|:| Stﬂrti.mnituringl 18 12 8 o

3. Prva slika prikazuje izgled alatne trake kada zvuéni signal nije
dovoljno intenzivan. U ovom slucaju potrebno je glasnije
govoriti, provjeriti ispravnost mikrofona ili pomaknuti kliza¢ za
pojaCavanje intenziteta zvuka unutar alatne trake Mixer
Toolbar. Druga slika prikazuje optimalni intenzitet zvuka pri
snimanju, a zadnja slika jaci intenzitet zvuka.

i i ] . . | . . i
-.!,; :i -o4 43 42 36 -30 -24 -18 =12 -6 El
¢ L , | ! . . | 0 . i
Y r -534 -48 -42 -36 -30 -24 -18 -12 -8
[ L 1 g g I
Y r -54 -48 -42 -36 -30 -24 -18 -12 6

2.7. Kontrole reprodukcije i snimanja

Koristeci alatnu traku Transport kontroliramo reproduciranje i snimanje
zvuénih zapisa.

Hn b B |« » @

@ srce .

NAPOMENA

Za vise informacija o
podesavanju postavki
posjetite:

http://www.wikihow.com/C
onnect-Audio-Devices-to-
Computers



http://www.wikihow.com/Connect-Audio-Devices-to-Computers
http://www.wikihow.com/Connect-Audio-Devices-to-Computers
http://www.wikihow.com/Connect-Audio-Devices-to-Computers
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Mogucnosti reprodukcije su:
e Dugme Play " koristi se za poc¢etak reproduciranja.

e Dugme Pause " Koristi se za pauziranje i ponovno pokretanje
reprodukcije ili snimanja. Reprodukcija ili snimanje nastavljaju
se na mjestu gdje su zaustavljeni.

e Za zaustavljanje reprodukcije ili snimanja potrebno je odabrati

Stop " . Nakon zaustavljanja, zvucni se zapis reproducira od
pocetka.

e Skip to start " i Skip toend " premjesta pokaziva¢ na
pocetak ili kraj zvu€nog zapisa.

e Za pocetak snimanja odabire se dugme Record ° .

¢ Razmaknica na tipkovnici koristi se za po€etak i zaustavljanje
reprodukcije ili snimanja.

Prije poCetka obrade zvuka, reprodukcija ili snimanje moraju biti
zaustavljeni odabirom dugmeta Stop.

2.8. Snimanje zvuka u Audacityju

Nakon testiranja rada mikrofona, koraci za snimanje su:

1. Odabirom dugmeta Record iz alatne trake Transport pokrec¢e
se snimanje.

I b n I« bl ®

2. Za pauziranje snimanje odabire se Pause, dok se za potpuno
zaustavljanje snimanja odabire Stop.

I > u I« 4! ®

3. Snimljeni zvuk prikazuje se u srediSnjem dijelu sucelja kao
zvucni zapis.

4. Zvuini zapis reproducira se odabirom dugmeta Play.

I | 2 . 14 ! W

* @ srce
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2.9.

o b~ o N

Vjezba: Spajanje mikrofona i slusalica na
racunalo i snimanje zvuka

Ako imate otvoren Audacity, zatvorite ga bez spremanja
datoteke projekta.

Spojite mikrofon i sluSalice na racunalo.
Otvorite Audacity.
Testirajte ispravnost mikrofona.

Snimite sljededi tekst: ,Audacity je besplatan program
otvorenog koda za snimanje i obradu zvuka, a dostupan je za
operacijske sustave Windows, OS Xi Linux. Audacity se moze
koristiti za preklapanje naracije s pozadinskom glazbom,
uklanjanije ili izoliranje naracije, izradu petlje zvuka (engl. loop),
izradu tonova zvona mobilnog telefona, izvoz zvu¢ne datoteke
koja se moze reproducirati na raCunalu, rezanje zvu¢nog zapisa
na vise zvucnih zapisa.”

Odaberite dugme Stop za zaustavljanje snimanja.
PresluSajte snimljeni zvuk.
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3. Uvoz i izvoz zvuénih datoteka, e

spremanje projekta Trajanje
poglavlja:
Po zavrSetku ovog poglavlja polaznik ¢e moci: 35 min

. uvesti zvuénu datoteku
° razlikovati razli¢ite formate zvucénih datoteka
° izvesti razlic¢ite formate zvucénih datoteka

e spremiti projekt.

Zvucni format je datote¢ni format koji se koristi za spremanje digitalnog
zvuka na raCunalnim sustavima, dok se sva obrada u Audacityju
sprema kao projekt u datoteCnom formatu .aup3.

Formati koji se mogu uvesti u Audacity su:
e nekomprimirane zvu¢ne datoteke WAV i AIFF
e komprimirane zvuéne datoteke Ogg Vorbis, FLAC, MP2 i MP3.

Nekomprimirane zvu¢ne datoteke sadrze originalnu kvalitetu zvuka
koja je dobivena prilikom snimanja. Kako bi se dobile zvu¢ne datoteke
manje veli€ine, zvuéni se zapis komprimira, ¢ime se gubi kvaliteta
zvuka.

Za koriStenje dodatnih formata zvuénih datoteka (MP3, AC3, AMR(NB),
M4A, MP4 i WMA) potrebno je instalirati uvozno-izvoznu knijiznicu
LAME MP3 encoder i FFmpeg import/export library. Za instalaciju
knjiznice potrebno je preuzeti datoteku s Interneta
(http://audacityteam.org/download/windows) i instalirati je na racunalo.

3.1. Uvoz zvucénih datoteka

Za uvoz datoteke:

1. Odabire se izbornik File > Import > Audio.

€ Audacity
File Edit S5elect View Transport Tracks Generate Effect Analy:
Mew Ctrl+N I =
> ® —
Open... Ctrl+0
i Q &
Recent Files »
Cloce Ctrle W Realtek High C ~ 2 (Sterec) Record ~
1.0 2.0 3.
Save Project » N . n . n
Expeort 5
Import ¥ Audio.., Ctrl+Shift+]
Page Setup.. Labels...
Print... DL
Raw Data...
Exit Ctrl+C
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2. Pojavljuje se dijaloski okvir Select one or more audio files... u
kojem se prikazuje struktura mapa i podmapa na racunalu. Kad
se pronade, odabere se Zeljena zvu€na datoteka i pritisne se

dugme Open.

€ Select one or more files X
Lookn: | || Viezbe v @ & @
* Marme - Dste modified Size
Projekt]_date 2242016, 11:41 File folder
Guckaceess Projekt?_data 2242016, 11:41 File folder
Projekt3_data 2242016 11:41 File folder
| Projektd_date 2242016, 11:41 File folder
Desktop Rjesenje_5_3_data 2842016, 15:06 File folder
— Vjezba 7-1 2242016 11:41 File folder
m Vjezba 7-2 2242016, 11:41 File folder
Libraries Vjezba 7-3 2242016, 11:41 File folder
neracija.mpd 22.1.2016. 11:17 MP3 File 1.563 KB
&) | ! pozadinska_glazba.mp3 2112.2015. 16:17  MP3 File 1928 KB I
This PC APkt aup 7212016, 10:45 Fudacy Project For il
Projektl.mp3 2742016, 16:34 MP3 File 7447 KB
@ EProjekt2.aup 22.1.2016. 10:52 Audacity Project F... 24K8
Network  ¢¥Projektz.aup 22.1.2016. 11:06 Audacity Project F.. 13KB
EProjektd.aup 2212016, 11:12 Audacity Project F.. 13 KB
I Rjesenje 5 3.2up 2842016, 15:06 Audacity Project F... 14 KB
Vjezba_7-1.mp3 18.42016.13:22 MP3 File 946 KB
Vjezba_7-2.mp3 18.4.2016.13:23 MP3 File 966 KB
Vjezba 7-3.mp3 18.42016.13:23 MP3 File 690 KB
Fors pozadinska_glazba mp3 o e ]
Fies of type Allfiles - Cancel

3. Nakon odabira, zvuéna se datoteka prikazuje u srediSnjem

dljelu sucelja

e e S e S 1| 60 e

| [roeomusTeaRs iamsomeooos |0 0/h100imI0 Ofst

WWNWM i HWWM WWW W

i Wm li wwwv

Alternativni nacin uvoza datoteke jest koriStenjem mogucnosti Povuci i
ispusti (Drag&Drop) kao $to je prikazano na slici.

Bez obzira na koji nacin uvezemo

zvucnu datoteku, ona se uvijek prikazuje
kao novi zvuéni zapis u srediSnjem dijelu

sucelja.

Moguce je uvesti viSe zvu€nih datoteka
koje ¢e u srediSnjem dijelu sucelja biti
jedna ispod druge i simultano ¢e se
reproducirati.

Projekt]_data “ Audacity

Projekt2_data File Edit Select View Tansport Tacks Generate |

Projeki3_data

Projektd_data n > ] 14 » [ ]

Rjesenje_5_3 data

Vjezba_7-1 H|J o o) Lo

Vjezba_7-2

Vietbs 73 Windows W ~| & | Microphone (Realtek High T | 2 (ste
naracija.mp3 E'U’ d;? 1.0 20
| pozadinska_glazba.mp3 ! : .
& Projekt1 \up

Projektl.m)
& Projekt2.aup
) Projeki3.aup
&) Projektd.aup
& Rjesenje 5_3aup
Vjezbs_7-1.mp3
Vjezbs 7-2.mp3
Vjezbs_7-3.mp3
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Nakon uvoza, zvu¢na datoteka je spremna za reprodukciju, obradu,
dodavanje efekata itd.

3.2. Stvaranje i spremanje projekta

Sva obrada zvucnih zapisa u Audacityju sprema se kao projekt. Tako
spremljen projekt moze se naknadno otvoriti i uredivati.

& Audacity
File Edit Select View Transport Tracks Generate Effect  Analy:
[ nNew Ctrl+N 1=
b o -
Open... Ctrl+ 0 a
b Q| e:
Recent Files » =
| Close Carle W Realtek High C ~ || 2 (Stereo) Record ~
Save Project » Save Project Ctrl+5
Export » Save Project As...
Import 5 Backup Project...
Page Setup...
Print...
Exit Ctrl+Q

Za stvaranje novog projekta iz izbornika File potrebno je odabrati New,
a za spremanije projekta potrebno je iz izbornika File odabrati Save
Project As.... Projekt se moze i zatvoriti odabirom Close iz izbornika
File.

Projekt napravljen u Audacityju sastoji se od jedne datoteke s
datote¢nim nastavkom AUP3.

3.3. lzvoz zvucnih datoteka

Projekt spremljen u Audacityju ima datoteCni nastavak .aup3 i datoteku
je moguce otvoriti samo tim programom. Zbog toga je potrebno projekt
izvesti, tj. zvuéni zapis spremiti kao datoteku koja se moze koristiti u
raznim programima i uredajima za reprodukciju glazbe. Audacity moze
izvesti zvu€ne datoteke s datotecnim nastavcima WAV, AIFF, MP3,
FLAC, Ogg Vorbis i mnogim drugim.

Za izvoz datoteke potrebno je:

1. Odabrati naredbu Export Audio iz izbornika File > Export (za
izvoz oznacenog dijela zvu€nog zapisa odabire se naredba
Export Selected Audio) ili odmah odabrati izvoz u jedan od tri
najCesce koristena formata za izvoz (MP3, WAV, OGG).

& pozadinska_glazba
File Edit Select View Transport Tracks Generate Effect Analyze Tools |

New CtrlsN 1=/ 4
b [ ]
Dpen.. Ctrl+0 Q -
Lk SEE
Recent Files >
—_— Cutey  [Realtek High € |2 (Stereo) Record |} [Speal
15 30 5 10
Save Project L | | .
Export > Export as MP3
Import > Export as WAV
Page Setup.. Export as 0GG
e | Export Audio... CrlsShift-£ |
Export Selected Audio...
(e &Y Export Labels...
1.0 Export Multiple... Ctrls Shift+L
1wl Export MIDI...
i
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2. U strukturi mapa i podmapa na raCunalu, koja se prikazuje u

dijaloSkom okviru Export Audio, odabrati mapu u koju ée se
izvesti datoteka.

r 1
@ Export Audio ==
Savein: | Projekti - @ rEr
7 Name Date modified Type
=l Mo itemns match your search,
Recent Places
Desktap
Libraries
LY
Computer
t o I | ’
& e izvoz - Save
Neterk Cone ]
Saveastpe: WAV (Microsoht) signed 165t PCM - [ caneal |

3. Odabrati Zeljeni datotecni nastavak iz padajuceg izbornika Save

as type.

S Other ncompressed files
Ogg Vorbis Files %

4. U tekstualni okvir File name upisati naziv datoteke i odabrati

dugme Save.

- S
@ Export Audio ||
Savein: |)l Projekti - @ r@E
I Name Date modified Type
E No items match your search
Recent Places
Desktop
Libraries
A
Computer
~ o i ] v
Fie name izvoz - Save
Network
Save as type | WAV (Microsoft) signed 165t PCM -] | [ Cancel |
T
WAV (Vicrosoft) signed 16t FCM Options
WAV (Vicrosoft) 32 float PCM

FLAC Files

WMP2 Files

{extemal program)

W47 (AAC) Files (FFmpeg)

AC3 Fies (FFmpeg)

AMR fnamow band) Files [FFmpeg)
VIMA (version 2) Files (FFmpeg)
Custom FFmpeg Export

s N
@ Export Audio [
Savein: || Projekti - @ rEr
= Mame - Date modified Type
":} Mo items match your search.
Recent Places
Desktop
Libraries
iy
Computer
i < i ] v
L =4 Filz name: | izvoz - | -m
Network
Save as type: [MFH Files - I Cancel ]
\
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3.4. Vjezba: Uvoz datoteke, kontroliranje
reprodukcije i snimanja, spremanje projekta

1. Otvorite Audacity.
2. Snimite sljededi tekst:
< Pauza oko 5 sekundi. >

~LAudacity je besplatan program otvorenog koda za snimanje i
obradu zvuka koji je dostupan za operacijske sustave Windows,
OS Xii Linux.”

< Pauza oko 5 sekundi. >

»+Audacity se moze koristiti za preklapanje naracije s
pozadinskom glazbom, izolaciju ili uklanjanje naracije, izradu
petlje zvuka, izradu tonova zvona, izvoz zvuéne datoteke koja
se moze reproducirati na racunalu, rezanje zvu¢nog zapisa na
viSe isjeCaka te spajanja dijelova zvucnih zapisa.*

< Pauza oko 5 sekundi. >

,Bez obzira na koji nacin uvezemo zvu¢nu datoteku, ona se
uvijek prikazuje kao novi zvuéni zapis u srediSnjem dijelu
sucelja.”

< Pauza oko 5 sekundi. >

.Neke od mogucnosti ovog programa su: snimanje i
reproduciranje zvuka, uvoz i izvoz razli¢itih formata zvuka,
obradivanje rezanjem, kopiranjem i lijepljenjem dijelova
zvucnog zapisa, tj. spajanje razliitih zvucnih zapisa,
preklapanje vise zvuénih zapisa, dodavanje raznih efekata,
uklanjanje Sumova i buke, ubrzavanje i usporavanje zvuénog
zapisa, postupno smanjivanje i poja¢avanje intenziteta zvuka,
dodavanje jeke i mnoge druge.”

< Pauza oko 5 sekundi. >

3. Preslusajte svoju snimku (pritisnite dugme Play), pauzirajte
reprodukciju na dijelu naracije ,Bez obzira...“ dugmetom Pause.

ZapiSite u kojoj ste minuti i sekundi zaustavili zvuéni zapis:

4. Dugmetom Stop ponistite pauzu reprodukcije kako bi mogli
nastaviti uredivati zvuéni zapis.

5. Uvezite zvuénu datoteku pozadinska_glazba.mp3 iz mape
Vjezbe.
Izvor: Drops of H20 ( The Filtered Water Treatment ) by J.Lang (c) 2012 Licensed under a

Creative Commons Attribution (3.0) license. http://ccmixter.org/files/djlang59/37792 Ft:
Airtone
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Spremite projekt pod nazivom Projekt1.aup3 u mapu Projekti

PresluSajte kako se naracija preklapa sa uvezenom zvuénom
datotekom i napiSite svoj prijedlog daljnje obrade.

Izvezite zvu¢ne datoteke formata MP3, Ogg Vorbis i WAV (WAV
(Microsoft) 32-bit float PCM) s imenima ,mp3_zvuk®,
,09g_vorbis_zvuk® i ,wav_zvuk, u mapu Projekti.

ZapiSite veli€inu pojedine datoteke u MB:

e mp3_zvuk.mp3:

e 0gg_vorbis_zvuk.ogg:

e wav_zvuk.wav:

Otvorite datoteku mp3_zvuk.mp3 u programu Windows Media
Player.
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4. Osnovna obrada zvuénog zapisa

Po zavrSetku ovog poglavlja polaznik ¢e moci:
e upotrijebiti alate za promjenu prikaza zvuénog zapisa

o oznaciti dijelove ili cijeli zvucni zapis

° izrezati, kopirati, obrezati i obrisati zvucni zapis.

Prije digitalne ere, obrada zvuka vr$ila se pomocu zileta i ljepljive trake.
Magnetska traka bi se rezala i ljepila na drugu ili uklanjala po potrebi.
Mnoge tehnike i izrazi koji su se koristili u proslim erama obrade zvuka
koriste se danas i dobra su podloga za izradu programa za obradu

zvuka.

Razvojem tehnologije racunala zamjenjuju strojeve za magnetske

trake, digitalni dokumenti magnetske trake, a raCunalni programi

automatiziraju vecéinu procesa koji su se morali obavljati ruéno. Tako
Covjek snima i obraduje zvuk racunalom, §to cijeli proces Cini brzim,

jednostavnijim i zauzima manje fiziCkog prostora.

Kako bi se odredeni dio zvuka pravilno obradio pomoéu rezanja,
lijepljenja, premjestanja i sl.,

obradu zvuka, a ujedno i teme ovog poglavlja.

potrebno ga je pravilno prikazati i oznaciti.
Prikaz, oznaCavanje zvu€nog zapisa i rezanje najkoristeniji su alati za

4.1. Prikaz zvuénog zapisa

Jedna traka predstavlja jedan izvor zvuka u cjelokupnom zvuénom

zapisu. Moguce je dodavati ili snimiti viSe zvuénih zapisa kao sto

postoji vise instrumenata u glazbenom sastavu koji se medusobno

preklapaju.

Svaki prikaz zvuénog zapisa sadrzi:

A. plo€u s postavkama zvuénog zapisa

B. vertikalnu skalu s jedinicama

C. vizualni prikaz valnog oblika.

P
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Nova traka stvara se svaki put pri umetanju nove zvuéne datoteke ili
shimanju zvuka. Takoder se moze dodati nova prazna traka, mono ili
stereo, odabirom Mono Track ili Stereo Track iz izbornika Tracks >
Add New.

Stereo je reprodukcija ili snimanje zvuka koriStenjem dva ili viSe
neovisna zvuéna kanala (kao na slici ispod), dok se mono zvucéni zapis
koristi samo jednim zvu¢nim kanalom. Lijevi kanal stereo zvuénog
zapisa nalazi se na gornjem dijelu zvu¢nog zapisa, a desni kanal na
donjem dijelu.

15

Xlpomsimia ] 10
e | sob
P

. "

G o

Donja traka zvu¢nog zapisa prikazuje mono zvucni zapis, gdje se isti
zvuk reproducira na lijevom i desnom kanalu zvucnika.

15 )

NP TP T PPN www " wnww
L . i NIRRT AT

Ako zvucni prikaz dodiruje i gornji i donji dio trake, zvuk ima jaci
intenzitet i obratno.

Svaka zvucna traka moze se pomicati po vremenskoj liniji, tj. moze joj
se odrediti vrijeme pocetka reprodukcije. Ravnalo iznad traka zvuka
prikazuje duzinu zvuénog zapisa u minutama i sekundama.

Pojedine zvuéne trake mogu se zatvoriti odabirom dugmeta X unutar
ploCe s postavkama zvuénog zapisa.
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4.2. Povecéavanje i smanjivanje prikaza zvuénog
zapisa

Za detaljniju obradu dijelova zvuénog zapisa ili pregledavanije cijelog
projekta ili zvuénog zapisa koriste se alati za poveéavanje i
smanjivanje prikaza zvuénog zapisa. Spomenuti alati ne vr$e obradu
zvuka, ve¢ mijenjaju njegov prikaz u svrhu jednostavnije obrade.

Povecanje i smanjivanje prikaza pomocu alatne trake Edit

Za pregledavanije cijelog zvu€nog zapisa ili samo jednog dijela koriste
se alati za uveCavanje i smanjivanje unutar alatne trake Edit.

KQE) o =~ | @,

Za smanijivanje prikaza, kako bi se prikazao cijeli zvuéni zapis, koristi
se dugme Zoom Out 2. Slika ispod prikazuje cijeli zvuéni zapis koji
traje pet minuta i 15 sekundi. Trajanje prikazanog dijela zvuénog
zapisa moze se vidjeti na vremenskoj liniji iznad njega.

0 AR

Za uvecavanje prikaza zvu€nog zapisa, kako bi se vidjeli detalji, koristi

se dugme Zoom In €/ Na slici ispod prikazan je isti zvuéni zapis, ali
uvecan pa se vidi samo isje€ak od 2. minute i 13. sekunde do 2.
minute i 55. sekunde.

Poveéanje i smanjivanje prikaza pomocu izbornika View

View Tapsport Tracks Generate Effect Analyze Tools Help

Spomenute i dodatne moguénosti

Zoom > Zoom In Ctle1 |

s pripadajuc¢im pre€acima mogu e (| oom e o

se odabrati i u izborniku View -> History.. Zoom o Selection chieE
! Karsoke... Zoom Toggle Shift+Z

Zoom' Mixer Board... Advance d Vertical Zoomin q
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NAPOMENA

Za vise informacija o
oznacavanju posjetite:

http://manual.audacitytea

m.org/o/man/audacity se
lection.html.

Povecéanje i smanjivanje prikaza pomo¢u dugmeta Zoom Tool

Povecanje i smanjenje prikaza zvu€nog zapisa moguce je i 1=/

odabirom dugmeta Zoom Tool Q iz alatne trake Tools. Q |‘-’ X

Za povecavanje prikaza potrebno je postaviti strelicu miSa iznad
zvucnog zapisa i pritisnuti lijevu tipku mida, a za smanjivanje desnu
tipku misa.

Odredeni dio zvuénog zapisa moguce je povecati i alatom Zoom Tool
tako da se lijevom tipkom misa klikne na traku, i bez pustanja lijeve
tipke misa strelica se odvuce do Zeljene pozicije (za smanjivanje drzi
se i tipka [Shift]). Na slici ispod moze se vidjeti poCetak (lijeva
isprekidana crta) i kraj dijela zvu€nog zapisa koji ¢e se povecati (desna
isprekidana crta sa strelicom u obliku povecala).

Ssanea~] 10 T
s | son 1

|

ol ssea | |10 |

Povecéanje i smanjivanje prikaza pomocu tipke [Ctrl] i kotadi¢a
misa

Prikaz zvu€nog zapisa moguce je povecati ili smanijiti tako da se
strelica miSa smjesti na zvuéni zapis, zatim se pritisne tipka [Ctrl], a
kotaci¢ mida okrece se prema gore kako bi se prikaz zapisa povecao ili
prema dolje kako bi se prikaz zapisa smanijio.

4.3. Oznacavanje dijelova zvuénog zapisa

Kako bi se alati za obradu zvuka mogli primijeniti, u Audacityju je
potrebno oznaditi dio zvu€ne trake ili pak cijelu zvuénu traku, a
ponekad je potrebno oznaditi i vise zvucénih traka. Oznaceni dijelovi
mogu se premjestati, brisati, rezati ili se na njih mogu primijeniti efekti.

Za oznacavanje odredenog dijela zvu€nog zapisa potrebno je odabrati

alat Selection Tool I iz alatne trake Tools. Alatom Selection Tool
odabere se pocetna to¢ka zvuénog zapisa koji se Zeli oznaditi, a zatim
se strelica miSa odvuce na lijevu ili desnu stranu do Zeljene krajnje
tocke odabira. Oznaceni dio bit ¢e tamnije boje od ostatka zvu¢nog
zapisa, kako je prikazano na slici ispod.
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Za poniStavanje odabranog dijela, potrebno je kliknuti bilo koji dio
zvucnog zapisa lijevim klikom misa ili odabirom opcije None iz
izbornika Selecet > None.

Cijela traka moze se oznaciti odabirom sive povrsine ploCe s
postavkama zvuénog zapisa, a sve trake moguce je odabrati odabirom
opcije All iz izbornika Select > All.

Oznaceni dio zvu€nog zapisa reproducira se odabirom dugmeta Play,
a za ponovno reproduciranje cijelog zvuénog zapisa potrebno je
ponistiti odabrani dio.

Za povecavanije ili smanjivanje oznacenog dijela zvu€nog zapisa
odabere se njegov rub. Kada se strelica miSa pretvori u ruku
ispruzenog kaziprsta, zvu€ni se zapis povlaci u Zeljenom smjeru kako
bi se oznaceni dio povecao ili smanjio.

V| 180 190 200 210 220 230 20 250 20 210 280 200 300 310 320 330

Foesrse v 10

e | S0

Too 05
L ®
°

Al sekct | |10

Detaljnije mijenjanje poCetka i kraja ozna¢enog dijela moguce je unutar
alatne trake Selection, upisivanje to¢nog vremena pod Selection Start
i End, kao $to je prikazano sa slici ispod. 1z alatne trake Selection u
prozoru Audio Position moguce je vidjeti trenutnu vrijeme
reprodukcije, ozna¢eno zadnjim crvenim okvirom na donjoj slici (26
sekundi).

Project Rate (Hz) | Snap-To Start and End of Selection “

off - ||00h00m25.?51s'"00h00m25.?51s‘i 00hO0Om26 s-
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4.4. lzrezivanje, kopiranje, obrezivanje i brisanje
zvucénog zapisa

Izrezivanje, kopiranje, obrezivanije i brisanje najeSée su naredbe za
obradu zvuka.

Nakon oznacavanja, zeljeni dio zvuénog zapisa moze se izrezivati,
kopirati, obrezivati i brisati. Spomenute moguénosti dostupne su u
izborniku Edit i alatnoj traci Edit.

XD O wi] =~ &QQQ

e Cut K uklanja oznaceni dio trake i smjeSta ga u
meduspremnik kako bi se zalijepio na drugu traku ili u drugi
projekt.

Na mjestu gdje Ce se zalijepiti izrezani dio trake potrebno je

postaviti Selection Tool I i odabrati naredbu Paste ) iz
izbornika Edit ili iz alatne trake Edit.

e Copy |_|:| ostavlja oznacCeni dio trake na mjestu i smjesta
njegovu kopiju u meduspremnik kako bi se zalijepio na drugu
traku ili u drugi projekt.

Na mjestu gdje ¢e se zalijepiti kopirani dio trake potrebno je

postaviti Selection Tool I i odabrati naredbu Paste [ iz
izbornika Edit ili iz alatne trake Edit.

e Trim Audio "™ brise dio zvuéne trake koji je ispred i iza
oznacenog dijela zvu¢nog zapisa.

e Silence Audio " oznageni dio trake pretvara u tidinu.

e Delete iz izbornika Edit ili tipka [Delete] na tipkovnici uklanjaju
oznaceni dio trake.

4.5 Brisanje i vrac¢anje zadnje akcije

Naredba Undo *™ briSe posljednju primijenjenu naredbu. Moguce je
vratiti svaku akciju od pocetka otvaranja projekta, a popis sa svim
akcijama nalazi se u izborniku View - History.

Odabirom naredbe Redo 7™ ponistava se brisanje, tj. vra¢anje akcije.

Obje naredbe dostupne su u izbornika Edit i alatnoj traci Edit.

KOO i @&
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4.6

Vjezba: Osnovna obrada zvuka

Otvorite projekt Projekt1.aup3 koji ste samostalno izradili u
prethodnoj vjezbi i spremili u mapu Projekti.

Ako nemate spomenutu vjezbu, koristite se projektom
Projekt1.aup3 koji se nalazi u mapi Vjezbe.

Kako nam pozadinska glazba ne bi smetala pri obradi naracije,
potrebno ju je u potpunosti stiSati.

Odaberite opciju Mute na ploCi s postavkama zvu¢nog zapisa
(lijevo od prikaza zvu€nog zapisa) pozadinske glazbe kako bi
potpuno stiSali pozadinsku glazbu.

Oznacite dio naracije: “Audacity se moze koristiti za preklapanje
naracije s pozadinskom glazbom, izolaciju ili uklanjanje
naracije, izradu petlje zvuka, izradu tonova zvona, izvoz zvuéne
datoteke koja se moze reproducirati na racunalu, rezanje
zvu€nog zapisa na vise zvu¢nih zapisa.“

Oznaceni dio naracije izreZite i zalijepite na kraj zvucne trake.

Oznacite i izbriSite dio naracije ,Bez obzira na koji nacin
uvezemo zvucnu datoteku, ona se uvijek prikazuje kao novi
zvucni zapis u srediSnjem dijelu sucelja.” koristec¢i naredbu
Delete.

Smanijite vremenski razmak izmedu odlomaka sa pet sekundi
na dvije sekunde koristec¢i naredbu Delete.

Pretvorite vremenski razmak izmedu odlomaka u tiSinu koristeci
naredbu Silence Audio.

Odaberite opciju Mute na ploci s postavkama zvuénog zapisa
(lijevo od prikaza zvuénog zapisa) pozadinske glazbe kako bi
ponovno uklju€ili pozadinsku glazbu.

Spremite projekt pod nazivom Projekt2.aup3 u mapu Projekti.
Spremljeni projekt koristit ¢e se u sljedeéoj vjezbi.
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5. Napredna obrada zvu¢nog zapisa -

Po zavrSetku ovog poglavlja polaznik ¢e moci: Trajanje

e  Sstvaratii uredivati isje¢ke poglavlja:

e upotrijebiti alate za smanjivanje i pojaéanje intenziteta zvuka. 30 min

IsjeCci se koriste za rezanje dijelova naracije i premjestanje dijelova
govora, u izradi petlji ili premjeStanju dijelova trake na druge trake zbog
lak8e manipulacije zvuénog zapisa.

PojaCanje i smanjivanje zvuka jedan je od vaznijih alata obrade zvuka.
Koristi se za lagane prijelaze zvuka iz tiSine ili u tiSinu, za uskladivanje
naracije i pozadinske glazbe ili miksanje.

5.1. Isjecci

Kada se zvu€na datoteka uveze u Audacity, ona je neprekinuta (prva
traka na slici ispod). Svaka neprekinuta traka moze se razdijeliti u
isjeCke (druga traka na slici) kako bi se zvu¢nim zapisom moglo lakse
manipulirati. Svaki isje€ak moze se pomicati neovisno o drugim
isjeCcima.

PO 1
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5.1.1. Dijeljenje traka u isjeCke
Postoji nekoliko nacina dijeljenja neprekinutih traka u isjecke:

e naredba Edit > Clip Boundaries - Split razdvaja isjeCak ili
cijelu traku tamo gdje je oznacena alatom Selection Tool.

e naredba Edit > Remove Special > Split Cut briSe oznaceni
dio trake, a od neoznacenih dijelova stvore se dva isjecka.
Obrisani isjeCak sprema se u meduspremnik i moze se
zalijepiti na istu ili drugu traku.

e naredba Edit > Paste prethodno izrezani ili kopirani dio trake
zalijepi kao novi isjecak.

@ srce #
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5.1.2. Spajanje isjeCaka

Dva isjeCka mogu se spojiti odabirom linije (prikazano na slici ispod)
koja ih razdvaja dok su smjesteni jedan do drugog.

uuuuu

nnnnnnnnnnnn

Al seect

Alternativno, isjeCci se mogu spojiti tako da se oznace alatom Selection
Tool, a zatim se odabere naredba Join iz izbornika Edit > Clip
Boundaries.

5.1.3. Premjestanje zvucnih isjec¢aka

J., -
Za premjestanje isjeCaka koristi se alat Time Shift Tool - IT A ﬂ
koji se nalazi u alatnoj traci Tools. Qe ﬂ

Nakon odabira isjeCka alatom Time Shift Tool, potrebno je kliknuti
ljevom tipkom miSa na zeljeni isjeCak i drzeci lijevu tipku miSa
premjestiti ga lijevo ili desno. Na isti nacin isjeCci se mogu premjestati
iz jedne trake u drugu.

5.2. Stisavanje i pojacanje intenziteta zvuka

Intenzitet zvuka moze se mijenjati za cijelu zvu€nu traku ili po
pojedinim segmentima. Preko plo€e s postavkama mijenja se intenzitet
zvuka za cijelu traku, dok se za pojedine segmente koriste alati
Envelope Tool i Selection Tool.

5.2.1. Plo¢a s postavkama zvuénog zapisa

Postavke pojedinacne zvucne trake nalaze se pokraj vizualnog prikaza
zvucénog zapisa (oznaceni dio na slici ispod).

| pozadinska_w|[ 1.0
Wute | Solo
= +
° 05
L R
©
Stereo, 44100z || o
32-it float i

0.5

1.0

A Select
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Neke od moguénosti su:

e Gain Slider - klizatem se mozZe smanijiti i pojacati intenzitet
zvuka u odabranoj zvuénoj traci

e Pan Slider - klizatem se regulira raspodjela zvuka na lijevom i
desnom kanalu

¢ Ime - naziv zvuéne trake
o Mute - alat ¢e u potpunosti stiSati traku prilikom reprodukcije

e Solo - alat ¢e reproducirati trenutnu traku, a sve ostale u
potpunosti ¢e stisati.

5.2.2. Envelope Tool

Envelope Tool omoguéava postupnu promjenu intenziteta zvuka

—_
dodavanjem kontrolnih tocki. Nakon odabira alata Envelope Tool =
iz alatne trake Tools, prikaze se tanka plava linija na vrhu i dnu valnog
oblika, kako je oznaceno na slici ispod.
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Za dodavanje kontrolne toCke potrebno je odabrati bilo koji dio plave
linije, nakon Cega ¢e se ona automatski pojaviti po vertikali zvu¢ne
trake (oznaceni dio na slici ispod).

| pozadinska_w| 1.0
Mute | Ssoo

oyl Uil

a| Ssekect 1.0

@ srce *



Audacity ili kako snimiti i obraditi zvuk u vlastitoj produkciji (R500)

Za povecanje intenziteta zvuka, kontrolna to¢ka premjesta se prema
gore, a za smanjivanje intenziteta prema dolje. Broj kontrolnih to¢aka
koje se mogu dodati na zvucni zapis nije ograni¢en. Na slici ispod
prikazane su Cetiri kontrolne tocke koje smanjuju intenzitet zvuénog
zapisa i ponovo ga pojacavaju.

Za uklanjanje kontrolne toCke potrebno ju je odabrati i odvuci izvan
trake.
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5.3.

o g~ 0 Db

10.
11.

Vjezba: Napredna obrada zvuka

Otvorite projekt Projekt2.aup3 koji ste samostalno izradili u
prethodnoj vjezbi i spremili u mapu Projekti.

Ako nemate spomenutu vjezbu, koristite se projektom
Projekt2.aup3 koji se nalazi u mapi Vjezbe.

Naraciju podijelite u isjeCke prema odlomcima.
IzbriSite tiSinu izmedu isjecaka.

Odvojite isjeCke tako da izmedu njih bude 7 sekundi.
Zamijenite drugi i treci isjeCak naracije.

Skratite pozadinsku glazbu da vremenski traje jednako dugo
kao i naracija.

Smanijite intenzitet pozadinske glazbe preko kontrolne ploce
zvuCne trake, da ne ometa zvuk naracije.

Napravite postupno pojacanje intenziteta zvuka pozadinske
glazbe na pocetku trake i postupno smanjivanje intenziteta
zvuka na kraju trake.

Izmedu isjeCaka potrebno je pojacati pozadinsku glazbu
postepenim pojaCavanjem i smanjivanjem intenziteta zvuka

PresluSajte dodane izmjene.

Spremite projekt pod nazivom Projekt3.aup3 u mapu Projekti.
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6. Primjena i vrste efekata

Po zavrSetku ovog poglavlja polaznik ¢e moci:

e  primijeniti efekte na zvucnu traku ili njezine dijelove.

Zvucni efekti koriste se za naglasavanje i korekciju cijelog i djela zvuka.
Audacity posjeduje veliku koli¢inu efekata koji se koriste za
izobliCavanje i promjenu zvuénog zapisa, kao $to je promjena brzine,
uklanjanje Sumova, pojacanje i smanjivanje intenziteta, izolacija
naracije itd.

6.1. Primjena efekata

Za primjenu efekta potrebno je oznaditi dio zvuénog zapisa i odabrati
zeljeni efekt iz izbornika Effect. Nakon odabira efekta otvorit e se
prozor s postavkama efekta u kojem je, pomocéu naredbe Preview,
moguce poslusati zvu€ni zapis s primijenjenim efektom prije nego to
se sam efekt primijeni na odabrani dio zvuénog zapisa.

6.2. Vrste efekata

Audacity ukljuuje mnogo efekata i takoder ima moguénost dodavanja
novih pomoc¢u dodataka.

NajceSce koristeni efekti su:

¢ Noise Reduction — smanjuje pozadinsku buku kao §to su
glasovi, zvizdanje, Sumovi i sl. Za smanjivanje pozadinske buke
potrebno je odabrati dio zvu€nog zapisa koji sadrzi uzorak
pozadinske buke. NajceS¢e je to tiSina izmedu re€enica. Nakon
odabira pozadinske buke potrebno je kliknuti na Get Noise
Profile iz dijaloSkog okvira Noise Reduction u izborniku Effects.
Zatim se odabere dio zvu¢nog zapisa na kojem se Zeli smanijiti
pozadinska buka i u dijaloSkom okviru Noise Reduction dugme
OK.

Moise Reduction *

Step 1

Select a few seconds of just noise so Audacity knows what to filter out,

then click Get Noise Profile:
Get Moise Profile

Step 2

Select all of the audic you want filtered, choose how much noise you want
filtered out, and then click 'CK! to reduce noise.

Moise reduction (dB): .
Frequency smoothing (bands): '

Moise: (® Reduce () Residue

Preview 0K Cancel

Trajanje
poglavija:

20 min

NAPOMENA

@ srce *

Za vise informacija o
efektima posjetite
http://manual.audacitytea
m.org/man/Effect Menu.

Dodatni efekti mogu se
preuzeti s web-stranice:
http://web.audacityteam.
org/download/plugins.
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Amplify — smanjuje ili povecava intenzitet za odredeni broj

decibela.

Amplify — [m| x
Amplification (dB): | Bl

v
New Peak Amplitude (dB):

[JAllow clipping

Manage Preview 0K Cancel

Change Speed — mijenja brzinu za odredeni postotak uz

promjenu visine tonova.

Change Speed - [m| X

Change Speed, affecting both Tempo and Pitch

Speed Multiplier: | LEEHY Percent Change: | 0.000

Standard Vinyl rpm:  from | 33 v| to |33% ~

Selection Length

CurrentLength: |00 h00m09.285s
MNew Length: 00h00mD09.286¢s~

Manage Preview 0K Cancel

Change Tempo — mijenja brzinu za odredeni postotak bez

promjene visine tonova.

Change Tempo - u] X

Change Tempe without Changing Pitch

Percent Change: | 14.961

L
Bests per minute
Length (seconds)
from | 028 to

[ Use high quality stretching (slow)

Manage Preview Cancel

Echo — [m| X

Delay time (seconds):
Decay factor:
oK

Manage Preview Cancel

36
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Fade Out — postupno smanjuje intenzitet oznacenog dijela

zvuc€nog zapisa do tiSine.

il

n

Fade In — postupno poja¢ava intenzitet ozna¢enog dijela

zvu€nog zapisa pocevsi od tiSine.

il

by

Repeat — ponavlja oznaceni dio zvu€nog zapisa zeljeni broj

puta.
Repeat - ] x
MNumber of repeats to add:
Current selection length: 00 h 00 m 06.0753 s
New selection length: 00 h 01 m 06.827 s
Manage Preview oK Cancel 0

Bass and Treble — smanjuje i pojaCava niske i visoke

frekvencije neovisno jedne o drugo;.

X

Bass and Treble - o
Tone controls

(e v

Treble (dB): ]
Output

Volume (dB):

[ Link Volume control to Tone controls
Manage | | StartPlayback | Skip Backward | Skip Forward | [7]Enable Close Ay | @
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6.3.

1.

o o > »w

Vjezba: Primjena efekata

Otvorite projekt Projekt3.aup3 koji ste samostalno izradili u
prethodnoj vjezbi i spremili u mapu Projekti.

Ako nemate spomenutu vjezbu, koristite se projektom
Projekt3.aup3 koji se nalazi u mapi Vjezbe.

Oznadite svaki pojedini isje€ak naracije i smanjite pozadinsku
buku. Kao uzorak pozadinske buke mozete koristiti tiSinu
izmedu rec€enica.

Oznacite srednji isjeCak naracije i dodajte efekt jeke.
Presluajte dodane izmjene.
Spremite projekt pod nazivom Projekt4.aup3 u mapu Projekti.

Izvezite zvu€nu datoteke MP3 formata u mapu Projekti.

38
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7. Vjezba: Miksanje zvuka e

Trajanje
Miksanjem se mogu stvarati novi zvuéni zapisi iz postojecih poglavija:
koristenjem alata za promjenu intenziteta zvuka, premjestanjem, 30 min

spajanjem i preklapanjem traka i isjeCaka te uporabom razli¢itin
efekata.

1. U mapi Vjezba 7-1 nalaze se razliciti zvucni zapisi. U Audacityju
otvorite sve datoteke iz spomenute mape i podesite intenzitet zvuka
svake trake kako bi neke zvu€ne zapise naglasili, a neke postavili u
pozadinu. Zvuéna datoteka Vjezba_7-1.mp3 moze posluziti kao
inspiracija za miksanje.

2. Mapa Vjezba_7-2 sadrzi zvu€ne zapise s razli¢itim instrumentima
pomocu kojih mozete izraditi viastiti glazbeni miks. Iskoristite barem 6
razli€itih zvuénih zapisa i izradite glazbeni miks u trajanju od najmanje
45 sekundi. Za inspiraciju mozete koristiti zvu¢nu datoteku Vjezba_7-
2.mp3.

3. Koristeéi zvu€ne zapise iz mape Vjezba_7-3 napravite glazbeni miks
§to sli¢niji onom u datoteci Vjezba_7-3.mp3.
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Prilog 1. — Detaljnije o radnom sucelju

Glavni izbornik

Mogucnosti glavnog izbornika su:

o File —rad s projektima Audacityja i drugim zvuc¢nim
datotekama

e Edit — obrada zvuénog zapisa
o View — prikaz zvuénog zapisa i alatne trake sucelja
¢ Transport — kontroliranje snimanja i reprodukcije

¢ Tracks — dodavanje, brisanje, poravnavanje i oznaavanje
zvuénih zapisa

e Generate — stvaranje novih zvukova (ton, tiSina ili Sum)
pomocu raznih dodataka

o Effect — kolekcija raznih efekata za obradu zvuka
e Analyze — analiza zvucnih zapisa

e Help — pomo¢, snimanje zaslona i razne informacije.

Alatne trake

Kako bi se pojedine alatne trake prikazale ili sakrile, potrebno ih je
odabrati iz popisa koji se prikazuje u izborniku View - Toolbar.

& noracia - o x
File Edit Select |View | Tapsport Tiacks Generste Effect Analyze Tools Help
no» Zoom > ’Tﬁﬁ M; 844842 Cickto Start Wontoring 18— —12 50 ﬂ; S s 42 3% S0 24 8 -2 b0
Tracksize > - T EEY
) 0 D ot 0[] -] |
lalelx ¢ D [ EEEY RIEYKeY
Windows v ey fereo) Record ) | Speakers (Reatek High Defir
91 o 45 00 115 130
T e TT el L

Mute | Sob Toolbars. > Reset Toolbars
ot || EdtraMenus (on/off)
v r

B )
Stereo, 441001z
32t foat

Transport Toolbar

Tools Toolbar

Recording Meter Toolbar
Playback Meter Toolbar

A
A
[N AN

<
ProjectRate (Hz) | Snap-To | |Start and End of Selection v ,7
w0 ]|jo  ~||[00m00m3329957 [00n00m3s3T4er 00h00m33s

Stopped.

® @ srce



Audacity ili kako snimiti i obraditi zvuk u vlastitoj produkciji (R500)

Alatne trake su:

Device — nudi mogucnosti biranja izvora snimanja i
reprodukcije (npr. biranje izmedu vise zvuénih kartica)

Windows W ~ -.!; Microphone (Realtek High C ~ || 2 (Stereo) Record ‘D Speakers (Realtek High Defir ~

Edit — nudi mogucnosti obrade (kopiranje, rezanje, brisanje) i
pregleda zvu€nog zapisa (povecavanje i smanjivanje)

KOO iy «~~ & QAQ

Recording Meter Toolbar — prikazuje jaCinu signala mikrofona
u realnom vremenu

L J 0 ; 0 0 l ; ; ; i
\.!J R -54 -45 -42 — Click to Start Monitoring ——18 -12 -5 ]

Playback Meter Toolbar — prikazuje jaCinu zvuka reprodukcije
u realnom vremenu

o) 'F-{ 54 45 43 3 3 24 18 42 & D
Mixer — regulira jaCinu zvuka snimanja i reprodukcije
- + - +
\ o o

Selection — kontrolira frekvenciju zvu¢nog zapisa projekta,
mogucnost Snap To i prikazuje to€no vrijeme reprodukcije

Project Rate (Hz) | Snap-To Start and End of Selection ~

44100 ~|[ of ~ ||00h00m33.299s~ [00h00m39.3745~

Tools — uklju€uje alate za ozna€avanje zvucnih zapisa, zatim
njihovo brisanje, premjestanje i dodavanje efekata

1=/
Q| kK

Transcription — omogucuje reprodukciju sporije ili brze od
originala

| +

o
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o Transport — omogucuje kontroliranje reprodukcije, snimanje i
gibanje klizac¢a kroz projekt.

n > ® 4 » @

Zvucni zapisi

Dio sucelja sa zvu¢nim zapisima sadrzi prikaz mono i stereo zvuénih
traka s postavkama o kojima se moze viSe procitati u poglavlju 4.17.
Prikaz zvuénog zapisa.
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